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1. Getting Started with Movicon

1.1. Introduction to the Movicon X
Tutorial

Welcome to the Movicon tutorial. This tutorial is aimed at giving you a quick guided
demonstration of the main Movicon Scada/HMI platform techniques used. At the end of
this tutorial you will have learnt the most essential techniques for using Movicon base
functionalities.

Before going ahead with this tutorial you should first install the software by using the
setup procedures.

All the information in this document is based on the assumption that:

1. Windows XP is the operating system being used

2. The user knows how to use the Windows’ techniques

3. The user has sufficient knowledge on automation systems, on variable and PLC
concepts

For further information on each argument, please consult the Online Guide or the User’s
Manual

p‘_\ This Tutorial is referred to Movicon X release 10.2 SP1.







2. Projects

2.1. How to create and structure a
project

Starting up Movicon with the option command line, the program will start in Programming
mode (Developer). The last project being used is usually opened. The workspace will
display empty upon the first execution. The workspace uses the modern disappearing
window techniques and therefore just simply point the mouse on the Tab you require to
make it appear in the workspace. To keep the window displayed in the workspace use the
relevant commands as indicated below:

ol i shwaeas BB

Point the mouse near
the relative tab to
display the window

sadig By Gy eulg @

B outpr #} soprEpies (5 0L Experer
Fur e, prass F1

Movicon Workspace with hidden windows
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[+ ChantJIME
Dhedandt Spropiic ' 1024
Diatwdt Sprophic .. TEB

 awHaEuig @

To keep the window

displayed use fhe
relative commands:

+ X

;..1;!3..!.‘.--@1‘— 141 Z _1|J
For el press F1 " o S -

Movicon workspace with window kept displayed

Tip: you can close the property window and double click on it to let it
appear.

2.2. Creating a New Project

To create a new project, use the ‘New’ command from the File menu (Ctrl+N).

[ MOVICON X - [Design]

:| File | Edit Miew Tools  wWindow  Help
1 Hew... chrl+n | - |
3 Open... Chl40
Close
£
Save Chel+5 [
Prink Chrl+P

A Wizard will appear to guide you in creating the new project:




PROJECTS

‘Movicon3 72

Extendyour powear

Mew | Existing | Recent

H ¥ ¥ 9

Win3z Terminals WinCE Mobile Phones
platFarm (izse) platform (jZme)

Cancel

Open |
[ ==

First of all you need to select the type of platform on which the project must be run. In
this way the functions which are not supported by the selected platform will not be
available in programming mode (the selection can be changed later). Confirming this
operation will display the configuration window:
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Project Name

e

Fleaze, enter the name and the path where your
project will be zaved

M ame |<Enter project name heres:

Folder IE:'\DDcuments and SettingzhD aniele'\My DocumentsiMovic ;I |

[~ Cropt Core Project file
[ Crpt all Project Fesource files

H [ Compress all the files
[ Encode using Unicode UTF-16

Extendyourpowar

< Back Mest » Cancel Help

In the window (as shown above), you will need to enter the desired name of the project in
editing phase.

The other settings are not to be used for the time being but can be checked out in the
manual if wished.

Click on the Next button to open the ‘Users’ settings.

3 [ Password Protected Project

Developer Mame |<Enter project developer name here:

Developer Pazsward I

re-type Developer Pazsword I

[ Enable Pazsword Mng

¥ Create Default User Groups

v Create Users from MT /200075 Users - Sery |<Enter Sereer Mame b
[~ Enable Buntime Uszers changes

[~ Enable NT/20005<P U

¥ Enable CFR21-Part 11 Settings

Extendyourpowar

|

< Back Mest » Cancel Help
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The security settings can be defined in this window. We will skip this part for the time
being and go on with Next button to access the Driver settings.

Add Comm.Driver |z|

Ligt Aveailable Comm.Drivers Comm.Drver Properties

] ModBus
O todbus TCRIP
O todbuz Serial
] Siemens
] Allen Bradley
1 Miksubizhi
Applican
OMROM
Schreider =
Saia-Burgess
GE-Fanuc
Beckhoff
Fanazonic - M atzushita

Hilzzher
A =]

>

Froperty M ame

£

< Back MHest = Cancel Help

The drivers you wish to include in the project can be selected from this window. We will
also skip this part and leave it for later. We will not set anything at this stage. Now click
on Next button to reach the Screens Settings.

11
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Screens

-
Extendyourpowar

&

[7 Create #f Screens 10 ;I

v idd Screen Caption
¥ Add Screen Mavigation Bar

Default 5creen Width 1280 -
Default Screen Height 1024

L) Lkl

Drefault Colar ||

< Back Mest » Cancel Help

Here you can indicate whether or not to create screens in the project. You can also
indicate whether to create each one with a Title, and a contents navigation bar with scroll
page buttons on the bottom border.

The default setting can be left alone or adapted to your requirements which can always be

changed later.

Going still ahead with the wizard other windows will be shown for the configuration of the

possible historical, alarms etc..

On the last window, Alarm Settings, when confirming these operations with Finish button,
the wizard will proceed creating the project according to the settings carried out.

e The Wizard will create the project’s structure by pre-setting all the basic
configurations in automatic.

2.3. Workspace

By default, the Movicon workspace appear as shown below:

12
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Project Window.

clearly and intuitively
accessible.

All the project resources are

=

Editing screen —
graphics area

Properties Window.

All the praperties af the
selected object or resource are
grouped together in & clear
and simple way.

Ppe [ Yew Lok Smbos  Ioos  Windos  bHelb

BB

n,

b

LAl
E'
2
R £ O CERE CETS SN EUEN BN KNS INEY CAES EURY:|

T Akl e e Scriph Event |

IR I O

M Crestn a Wbl Nripag | (Sorick Explorer.
B A 4 e Mer I X RN R i ah AN GE 00 00015

W S e Bl e i

=l

8%

|

| Otwet [perma =] Peoc [idectuations) ==l
5 1

| e

Ineart 8 ey Baskc Scrptinth. 8 ey

Yot aren Syrepte e |

. Y e [
W oupe  E N oo Baplrer
Far e, press FL " @

Logic Explorer Window.

Command Pane. The Logic codes are availzble

The commands and

functions relating to
selected resource, which

based on the resource
selected.

Area Toolhoxes
The Toolboxes give

you quick access ta
the symbal and
ohject libraries.

can be inserted info the
project, are shawn here.

= The Movicon Workspace, windows, toolbars, properties can be full
\]j) customized.

2.4. Project Properties

Each Movicon project has properties, which are used to set all the project’s configuration
functions.

To display the project’s properties, click on the project name, at the beginning of its tree
structure, or select the name and activate the Properties Window with the right mouse
key.

13
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Project Explorer 4

Resaurces 1 -

-- T demo-x1

e DB Properties

X

|deemu:u—x1 Project
: = |

[+ Enable Statistics
[ Enable Admin &lerts
Admin Alerts Server

Startup Spnophic Q main
Startup Script @%
Shutdown Script &%
Startup Commands F
Shutdovern Commarnds F

[ Start Full Screen

[v Show Status Bar

[v Show Trace Bar

[ Hide Deskiop

[ Hide Start Button

[ Hide Task Bar

[ Hide Spstem Clock,

[ Disable Tazk Switching K...
[ Dizable Task Manager
[ Disable Chil+Al+DEL

=

[v Recpcle DB Connection
[ Send Admin Alerts

The Project’'s properties permit you to setup the general characteristics of the project
itself, among which are:

. Eventual encrypted file protection

. Selecting project’s destination Operating System
. Working Folder paths

. Setting Startup behaviour (runtime execution)

. Operating system access security

. Historical Log settings

. Tracing historical settings

~NOoO O WNR

- For further details on all the properties please refer to the Programmer’s

\ll) Manual.

2.5. Project Structure

The Movicon projects are built from a set of files XML format. Each project resource is
saved in a XML file in that project’s folder and in the subfolder of the relating resource.

14
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Unless specified otherwise, the projects are saved in the "Documents\Movicon Projects*
default folder.

The files, being ‘open’ thanks to the XML, can be encrypted and compressed in the project
by means of using the project’s properties .The structure of the files respects the structure
the resources provided in the Movicon project window.

Let's go over the structure of the project files in detail, using the Windows Resource
Explorer.

Prni Eoldor
Bl <name: movalr Yk it

El <name = movdlrec
ﬁ <name =, movevk :
&8 cname > maovnetclt i
ﬁﬁ <narme = . rmovneksyr
ﬂj <name =.movopcclient
a4 <Mame =, movpri
% <name = movrealkimedb
<name = movsch
<name =, movscl

= |2) RESCOURCES

I <name =

aph rEEEEEE e pEEE s Ry

-

[E R iy ]

[E; Synopkicl . movscr
Q Alarms. movscr
Q Main. rmayscr

&% Main.movace

= Basicl.movbas

Raszgurca Foldar

E Menal . rovrieny
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3. Tags

3.1. How to create Tags

To introduce a new variable (Tag) into the project you need to:

1. Select the Real-Time Database resource from the project window

Project Explorer x

Resources | —
ZEZ demo-x1
Ggreal Time DB
o List variables (Tags) ...
ﬁi List Comm.Drivers
;@List Structure Prokat.,,
Resources

2. Select the “Add a new Variable” command from the Command Pane found at the bottom

of the project window. You can also use the analog command by using the right mouse
key.

Project Explorer =

Resources | Tvpe o

I test”
Ggreal Time DB
& List wariables (Tags ...
[ AR 0000 Wiord (16 Bit w
3& List Cornrn, Drivers
mList Structure Protat, .,

A new variable will be created in the project with default name and properties. The
Properties Window, if hidden, is displayed by double-clicking on the new variable (if can be
further displayed by using the relevant command from the ‘View’ menu).

You now need to assign the properties deemed necessary, especially the General
properties, through the 'Properties Window’.

In our case we shall keep the default settings, with the PLC address to be assigned later.
However we shall briefly go over the main properties for you:

17
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Properties x
([v]¥aR00001 Variable (Tag) -
v X |3
= “
Name VAR00001 =
D'escription
Type Word [16 Bit without zign])
[ mitial Cluality Good
[« FRetertive non Shared
Alea Not'S| variable Property
Address 0 The crucial Tag properties
Diynamic = are in the general
[ Enable Statistic Data properties group
= Here you can sef the
Engineering Unitz name, data type, any
Cloze Bit String area/address and link to
Open Bit String the device's physical
[ Enahle address.
[ Inverse
Dead Band -1,000000
Fiaw kin. 0.000000
Fia b aw. 1000, 000000
Scale Min. 0.000000
Scale Max. 100000000
=
Winte Access Lewvel 0000
FRead Access Level FFFF
= =l

Let’s go over which are the fundamental properties of each Tag:
Name: permits you to assign the name desired for the variable.
Type: permits you to specify the data type (bit, byte, word, etc.)

Area: permits you to indicate whether an explicit memory area is to be used for the
supervisor. When leaving the area as ‘Not Shared’, the supervisor will decide if the tag
must be considered for the licence. The tag will be counted for the licence only if it's
exchanged with the field throught teh driver, OPC, ecc..

Dynamic Address: permits you to set the physical address to connect to the Tag to. The
Tags Explorer can be used to specify the connection by means of an 1/0 Driver, OPC or
Networking.

e All the other properties allow you to go and specify the Tag’s behaviour, in the
project, in detail. We, therefore, advise you to refer to the Programmer’s Manual
for further details.

We will leave the Tag with its default settings for the time being.

18



TAGS

3.2. How to Communicate with Drivers

New communication drivers (1/0 Drivers) can be inserted into the project at any time.

order to do this you need to:

1. Select the Real-Time Database Resource from the project window

Project Explorer

Resources

ZEZ demo-x1
Ggreal Time DB

o & List Variablas (Tags) ...
3@ List Carinn. Drivers
;@List Structure Pratat, .,

Resources

In

2. Select the ‘Add a new Comm.Driver’ command from the Command Pane found at the
bottom of the project window. You can also use the analog command by using the right

mouse key.

3. A window will appear through which you must choose the driver you need from the list

of drivers available.

4. Each driver is subdivided into product categories.

you the drivers and the relative communication protocols available.

By clicking on one product will get

-

Add a new Comm.Driver

4 &dd Carmm, Driver

Lizt &vailable Corm. Dirivers

Cormm.Crriver Properties

M odBuz
O TCrIP
O Senial
Siemens
O 5apis?
ABDF1X
O &EDF1x

O EtheMetP

Mitzubishi

O MELSEC-Fx

O MELSECQ TCP

O MELSEC-G Serial Format 1
Applicam

OMROM

Property M arne
=

k. | Annulla

19
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Check the communication driver relating to the product and the protocol desired.

e We will check the Siemens S7 MPI “PC Adapter” protocol for our example.
When confirming the operation the driver will be inserted into the project and added to the

list of drivers in the project window.
We can now proceed with necessary configurations through the properties window:

Properties x
P}F‘C fdapter Driver ﬂ

&1 | (7

Settings
Check for Jpdates

B

Settings
Alloves to edit the Comm.Diriver General Settings

First of all you must proceed with the driver settings configurations from the General
properties group.

Go to the ‘Settings’ item where you will find an activation button for accessing the
communication settings window.

3.3. Configuring the Driver

In this example we have chosen to use the Siemens S7-MPI PC Adapter driver as an
example. The techniques used are the same for all the other drivers accept a few protocol

specifications. The first thing to do is sort out the configurations of the driver's General
Characteristics.

20
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MpiPcAdapter

General r Stations r Tasks r About l

Property M amne
2 -
D ebug Window Falze
b ax Entriez 10000
Enable Log to file True
Log Filef ame
=
Metwork, Bitrate 187.5 KBit/zec
M ovicon MPI Address 1
Highest Address k1|
Only Master 1 j

k. | Annulla 7

1. Usually the default settings are left as they are accept for certain specifications required
by the device being used. As an example lets suppose we have a standard PLC with a
standard MPI connection for which we will keep the General default settings.

2. After the general settings, select the ‘Stations’ window needed for the communication
station settings which we will create for the driver.

-,

MpiPchAdapter

General Skations r Tasks r About l

ap Add .| Name |

| =

b
4

Edit the lizt of Stations.

T hiz feature allows to enter
and define the Station list

k. | Annulla T

21



TUTORIAL

3. Use the “Add” button to add the necessary communication station to the driver in order
for it to communicate.

4. When entering the new Station, its relating settings window will display through which

we will configure the communication details of our station for which we will only
concentrate on the fundamental properties.

Station Properties

Station Properties

-

Froperty Mame
= -
Station Wame Default Station
Error Threzhold 1
F.eep Opened True
=
Fort 1
Baudrate 38400
Byte Size g
Parity Odd
Stop Bitz 1 Stop Bit ﬂ

k. | Annulla 7

Station Name: Assign a name to the station. In our case we will put PLC1 (but any other
name is acceptable).

Port: Assign the serial port number being used. In our case we will use the COM1 serial
port, for which we will leave the value left at 1.

Baudrate, Byte Size, Parity, Stop Bit: Assign the parameters of the communication port.
In our case we will keep the Default settings. Station ID: this is the last property on the
list whose setting is based on the ID address set in the PLC.

communication modalities. For instance, the TAPI functions can be used for
communicating via modem or the Bridging functions used for
communicating via the modem on the PC, to use the same communication
port for the PLC's remote maintenance (eg. Teleservice). To get further
information on these features please consult the Programmer’s Manual.

\ir) All the other station properties permit you to further configure the

However, we will limit ourselves in using just the base functions relating to device
communication for the time being.

When confirming the settings, the communication station will be inserted in the
communication driver.

Other stations for communicating with other devices on different COM ports can also be
inserted with the same MPI protocol.

22
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MpiPcAdapter

General Skations r Tasks r About l

dk Add Narme |
~PLET |

= Edit

= Remove

h& Test Cable/Comnm.

Edit the lizt of Stations.

T hiz feature allows to enter
and define the Station list

k. | Annulla 7

When arriving at this point the driver should have been inserted and the device already
connected and ready for communicating. To verify whether all is in order and working
correctly we shall run a test by using the “Test Cable/Comm.” button. In this way Movicon
will be able to verify whether communication with PLC device has been set up correctly
and the cables are correct. Any errors found should then be resolved to ensure that
communication works correctly.

3.4. Assigning Physical Address to Tags

After having inserted at least one station, we will proceed with how to assign a physical
address to the Tags.

1. Select the Tag previously inserted into the project (or create a new one)

Project Explorer =

Resources | Tvpe o
I test”
Ggreal Time DB
&3 List Wariables (Tags) ...
] AROO00 Wiord (16 Bit w
3& List Cornrn, Drivers
;@List Structure Protat, .,

23



TUTORIAL

2. Double-click on it to open the Properties Window.

Properties
([w]vaR00001 Variable (Tag)

v % |[B2 4 B2 @

Mame YAROODO

Drezcription

Type Word [16 Bit without sign])
Initial Quality Good

[v Retentive non Shared

Area Mot Shared

Addrezs 0

Dynamic %l
[ Enable Statistic Data

L) x

Enaineering Units
Cloze Bit String
Open Bit String

C !Enal:-le ﬂ

Dynamic
Allows to enter the dynamic settings for thiz varniable

3. Select the ‘Dynamic’ property from the ‘General’ group to open the Tag Browser
window.

" Tag Browser @
4 ity Metwork r,ﬁﬂ OF‘V@ Comm. Drivers B
Lizt Comm.Crivers in the Project Cormnm.Driver Properties
T& PC Adapter Property M arne
=] -
Settingz
Check for Upd... j
4 ¥
ak. | Cancel

4. Select the Tab relating to the communication driver from the Browser window.

24
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5. Double-click on the PC Adapter previously inserted to open a window to assign the
physical address.

- o

Task Properties
~ Task Propetties

Property M amne
=
Station PLC1
=
Device Address DB1.DBWO

Device Address
Enter the device addreszs in Siemens notation [2.g. DB1.DBE]

k. | Annulla 7

6. Select the driver’s station with which you want to communicate with (in our example
we have only entered the station named PLC1), then you need to specify the device's
physical address in "Device Address" to which the variable is to be connected.

7. In our example, we shall connect the Word type variable called VAROOOO1 to the PLC’s
DB1 data block’s word DWO.

@ Note: You can also enter the syntax of the physical address In the Tag' s

~“Dynamic' property directly:
[DRV]PC Adapter.Sta=PLC1|Addr=DB1.DBWO

With the Tag property set, Movicon will establish communication with the device for
reading-writing data from the PLC on the corresponding variable during project runtime.

3.5. Importing Tags directly from PLC

The Movicon drivers offer an extremely useful feature when the database of ready-made
PLC variables is being used:

The 'Import-Update device database’ command, from the Command Pane, is made
available when selecting the driver from the Movicon project window.

When activating this command you will be request to select the file corresponding to the
PLC database. As we are using Siemens S7 we need to select the .SDF or AWL file by
means of the file selection window:

25
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rmﬁ
Cerca jn; IB Simatic 57 j L 5 EF-

S7-Exp-example, sdf

(8

Documenti
recentl

&

Desktop

D'ocumenti

€

Rigorze del
canmputer

Mome file: I j Apri I
Rizorse direte  Tipo file: ISystem Data Files [ 2df) ;I Annulla |

[~ Apriin sola letura

£

When selecting the file with the PLC database, the Movicon Import Device variables
window will open to allow you to select all or part of the variables contained in the PLC
database.

Please select the Device Wariables bo Import

003_M1_FrableForBefDioC - M165,7 - BOOL

Active_Check_Cicle - M303.0 - BOOL
Acustic_alarm - 42,5 - BOOL

AMTCS - MDBS26 - REAL
AMTR.4 - MD7 10 - REAL

Cancel
Aol 7Y - MDESE - DoRD H

Station: | pLeg LI

When confirming the operation the ‘Import’ button, Movicon will go ahead with:

26
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1. Creating the Tags in the Movicon project keeping the same name and type taken from
the PLC database

2. Assigning the relative physical address to each Tag

By using this useful function you can get the Movicon project’s Variables DB created and
completed with the device’s physical addresses assigned automatically in just a few

seconds.
Each Tag’s ‘Dynamic’ property will be shown associated with the following syntax (which

can be changed as pleased):

[DRV]PC Adapter.Sta=Default Station|Addr=M265.0|Typ=0

27






4. Screens

4.1. How to create a Screen

To create a graphic interface you need to used the project’s Screen resource.

1. Select the Resources Folder from the Project window’s tree structure.

Resources | Tvpe
- test”

=) Big Real Time DB

IE,‘.'E Resources

IJzers fnd User Groups

2. Select the ‘Add new screen in the project’ command from the Command Pane at the
bottom of the project window. You can also use the analog command by using the right

mouse key.
T THOVICON X - (Dvgn] - Seveont - fscvemmi] Llee
Pofle Ede Yew Lupa Sypbok  [odk  Wedow  pel .
3 Wt I A | - i =) x it i
1’. bE ] ezl il Bl | s H [ L i =
e —= = o
L1 E— T [ —
= P v icleiodadedanrdebhoBrdogrd oTriegabe@abifobolrdedoicdodrdshss rﬁmm;‘s«ﬁmmum:.j
-l ~ ok B wm[E v g
% e
i al 0 o E
E o T e (r 1024
CaFeal Trm 00 & o 758
- EEiariey T f
e = Insge Mg O
[=F o . [y o F
[ [T R . |m,_-_:l a -_I,,:
ERiosts Loggers Andien | = agn CF A g
[ [CEENTRRT Tt a B a
Bl et Ciject Ust - Mot Da
TR Sy b ot it iz = R
Schedber Dlrject List - T Erable. w
Lk Chld Progects ) . =
ﬁﬂﬂ-ﬂl&wmﬁ ? v Shoew i
B - Sgurem i
- Back Cokw [l BACKG.,
r Gesderd [ none
= Geachert [l WD
B T
- Tisin
N 5]
= okl
il " o Lepei Vo i
- Pl Soea . I
- = Enbiat
W Ak e Variabie Script Evend || | Eymep
) Create o webOeni homipag | | -
oY A a ot Poray s
o A & e Acrelerstor z
W% Inmert i v i Scrigt it [ S »
pd : 7 (] »
Bl oupe M niogEipesr o) SoiptEeplee
For Help, press Fi o

3. The new screen will be created in the project and displayed with its default settings in
the workspace.
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4. You can change the screens default properties through the Properties Window. This
window is accessed by double-clicking on the screen itself or by using the same command
from the View menu.

5. We will only deal with the screen’s background color properties. Please refer to the
Programmer’s Manual for details on the other properties.

6. Select the ‘Back Color’ property from the ‘Background’ property group and assign
white as the screen’s background color.

This property takes effect when being confirmed with the v key.

Properties x
|Q Screenl® Synoptic (Screen) j
v X |[BE 4 B3] @
-
- —
[ Mot Destroyable
[vw Fit irnwfindow

[+ Enable Scrollbars

[ Show OnMDI Tab

[v Show Synapsis

[ Spawn Thread Execution

B
Back Calor [l BACKGROUND SysE.l__
Garadient EEEEEEEEEEEEEEEEENEN
Gradient Color EEE EE N
Image HE EEETNTEEN
[ Tile Image EEEENEE EBN

B | |
o HE N N EEE BN

Back Color ] ] HBE HE [ |

Enter the Synoptic Background colo [} EEE EEE EEENE EEEEE

EEEEN EEEEEERN LN

Document's Calars

L] [ | EEE ENE
[ (]

Mare Colors, .,

7. Repeat this operation to introduce another screen into the project. By doing this we can
setup an example to be used in the ‘change page’ lesson up ahead.

4.2. Screen at the project startup

To get the screen to open automatically at the start of a project Runtime you need to
specify the screen in the project’s Execution properties.
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Resources
Eltest”
Ggreal Time DB
Resources

1. Double-click on the project name at the beginning of the project’s tree structure to

display the its properties, or select the name and activate the Properties Window with the
right mouse key.

Properties

b4
|£K kest* Project j

E RIS

[v Enable Statistics
[ Enable &dmin Slerts
Adrmin Alerts Server
Startup Synoptic Screenl
Startup Script

S hutdown Script
Startup Commands
Shutdown Commands
[v Start Full Screen
[v Show Statuz Bar

[« Show Trace Bar j

M e o~

i S SeiD

Startup Synoptic
Allowsz to enter the Synophic[Screen] to be loaded at startup

2. Select the Execution Property, then the ‘Startup Synoptic’ property. By using the
activation button, activate the window for selecting the screen desired. Then press the
‘Refresh’ button to add it to the list.
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*" Resource Browser — @
4] Q Synoptic {Screen) B
Fiter |
B Screent
) Screenz
4 3
0k, Cancel

3. We will select ‘Screen 1’ to use in our example (or you can select another one if you
prefer). Then confirm with OK.

The specified screen will be the one to open and display automatically at the project
startup.

4.3. Graphic Editing

We will now re-open ‘Screenl’ to examine the basic graphic editing concepts.

1. Double-click on the ‘Screenl’ resource, found in the Resource folder in the project
window, to open the screen

2. Use the drawings tools by taking them from the Toolbox positioned on the workspace’s
right border.

3. Select the ‘Basic Shapes’ from the Toolbox and then select the drawing to be used
graphically on the screen.
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4. After having selected the chosen drawing, double-click on the insertion point on the
screen and drag the drawing until you reach the size desired.

5. Repeat these operations to create the drawing you want on screen.

6. These graphic elements, once on the screen, can be given general, style and animation
properties by using the Properties Window as described below.
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4.4. Object Libraries

In addition to the Basic shapes provided in the Toolbox you can also access other graphic
object categories. These categories contain vectorial drawings with style and animation
properties similar to those of the basic shapes but already predisposed with execution
functions for which they have been designed for.
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To use the ToolBox’s Objects, simply select the object desired then double-click the
mouse to insert the object on the point of the screen where you want it to be and drag it
until you reach the size desired.
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basic shape category.

After having inserted the your chose objects, you can then proceed with assigning their
properties by using the Properties Window. Each object will have, apart from the
general properties, also style and animation properties, which are common to all objects,
and the execution properties specified for each single object.

i ‘ Please refer to the Programmer’s Manual for further details.

4.5. Symbols Library

Movicon provides a vast variety of graphic symbols in libraries which have been pre-built
purposely to meet all the graphical representation requirements in automation.

These symbol libraries can either be accessed through the ‘Symbol Libraries’ window,
displayed on the border on the right hand side of the workspace, or by using the analog
command from the ‘View’ menu.
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= This figure shows an example of the symbol
!JD: libraries in the Movicon workspace. You can | a
scroll the various categories by using the
Tabs or scroll arrows on the window

borders.

Each symbol from each category can be inserted on screen by simply using the Drag&Drop
techniques and re-sizing it as desired by dragging its borders just like any other graphic
object.

= The symbols can be configured in their properties just like any other
\J) drawing object, by using the Properties Window

Graphic editing example:

Insert a ‘Rectangle’ object into the screen from the ‘Basic Shapes’ ToolBox and a ‘Tank’
symbol from the Symbol Library.
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The rectangle being edited
in its style properties ..

.and after. The drawing's
General and Style properties
allow it to be completely

configured graphically.

4.6. Creating a Composed Symbol

All the drawing elements (Drawings, Symbols, Objects) can be grouped together in
Symbols and then added to the Symbol Library.

Now let’s proceed with inserting a few drawing elements which we will then associate to a
graphic symbol.

By following the procedure described above, insert a Rectangle and two Ellipses from the
Basic Shapes ToolBox to form the shape shown below:
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& =et of drawing elemenfs can
be grouped together to make
one symbaol and added to the
symbaol library.

Select all three elements with the mouse by clicking in the area and dragging the
selection.

The figure below shows how the drawing should look like with the reference object
highlighted for any eventual align commands.

With the right mouse key, in the workspace, select the Symbol — Group command to
group all three drawings together to make one symbol.
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Create the Group Symbal by
using the relevant commands
with the right mouse key.

The symbol can now be added to the Movicon Templates library by using the right mouse
key on Symbol -> Add to Library.
Any animations or codes associated to the symbol will also be kept in the library.

The composed symbols can be inspected in the project's tree structure. The objects and
the composed symbols are displayed in structures under the screen they belong to.
Therefore each components of each symbol can be selected singularly and configured in its
properties.
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Each ohject or symbol can be
inspected from the project’s
tree structure under the screen
it belong to.

When using this technique we suggest you assign a name to each symbol

or drawing so that they can be identified straight away
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5. Dynamic Animation

5.1. How to create Dynamic Animations

We will now look at the editing techniques used, which entail the association of Tags, for
creating dynamic animations.

5.2. How To create Dynamic Colors

In our example we have chosen to assign the animation properties to color the drawing’s
background in function with the VAROOOO1 tag previously introduced.

1. Activate the screen where the graphic symbols were inserted as described above.
2. Select the rectangle shape representing a tube.
3. Double-click or use the other techniques to display the Properties Window.

4. Select the Animation group from the Properties Window and then the Back Color
item.

43



TUTORIAL

b3

Properties
| 8 Symbal Symbal -

s [B]=]] @

<
b 4

DEEEEEEHEEEEHEBHEH

[+  Enable T
" ariable 75| YAROODD

Edit Back Color List...

[ Analog Color

-

Enable

Allowwz to enable the back calar animation

Check the ‘Enable’ box to enable the pre-selected animation function, then select the tag
among those inserted in the project’s RealTime DB.

Then select the ‘Edit back color list’ to set the activation thresholds of the tag and
the relating colors to be displayed.

A window for setting the Thresholds should appear.
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-~

Rectangle - Background Color

4 Colar Threshold l

Color | " alue I Wariable

&dd
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I 0000000

k. Annulla Applica

Edit

Bemove

Drefault

_ Ex |
[ e
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The window contains a series of standard default thresholds. Use the relative commands

on the side to delete, add of edit them.

Use the relative settings window, shown below, to add or edit the animation

characteristics:

Edit Threshold Color

Froperty | M ame

Walue 1.000000
Yariable [%gl

Mode normal

Blirk Time 00

Colar . Lime [(0OfFOD)
Blink. Color [ ] White [FFFFFF)

Cancel
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By using this window you can set the threshold values and he animation colors, as well as
other properties which are explained in the Programmer’s Manual.
Confirm the settings with OK.

" When you Run the project, changing the real-time value of Tag VAROO0O1,
\\J) you will see the change of color of the rectangle shape.

5.3. Other examples of Dynamic
Animations

We will now insert some animations requiring Word type tags, which can be inserted into
the project as described above in chapter 4.

Let’'s assume that two tags, VARO0OO1 and VARO0002, both in Word are available in our
example project.

We will demonstrate another example of dynamic animation for on screen symbol
movement: Composed Movement.

1. Open the screen and select the Symbol, created previously with the Rectangle and
Ellipse drawings grouped together, then activate the Properties Window.

2. Select the ‘Animations’ group and then Composed Movement. This animation sets
the graphic symbol to move on the screen along a trajectory line graphically drawn out
with the mouse in proportion to the tag values associated.

3. Check the ‘Enable’ box.

4. Associate the VAROOOO2 tag previously inserted

b3

Properties
| 8 Symbal Symbal -

| & [B]=] @

[« Enable

Y ariable 75| YAROODDOD2
Start 0, 000000

End 100,000000

1IEEEEEEBEBE

Yanable
Enter the compozed movement animation warable
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5. Confirm with ¥ .

6. Close the property window and activate the mouse’s right key commands from the
selected symbol. Select the ‘Edit Composed Movement’ item.

7. Drag the symbol’s shape to the end point, i.e. to the right hand side of the tank.
8. To insert the intermediate points of the path, double-click with the mouse on the line
and drag it to the intermediate point desired and continue like this until the trajectory

line is complete.

9. Press the ESC key when finished. You should get this result as shown below:

S

10. Select the Scaling box from the Animations properties group to activate the relating
settings window.

11. Associate the VAROOOO2 tag previously inserted.

12. Enter the 50-100 values as scale Percentage, so that the symbol remains visible at
50% of its scale as minimum value.

13. Select the direction of the scaled re-sizing (leave the default selection).
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Properties x
| 8 Symbal Symbal -
o ¥ |[FE 2 | @
= -
—
=
[+ Enatle
Y ariable 75| YARDODDO2
Start 0.000000 S
End 100.000000
Start Percent h0
End Percent 100
Type +:+ center
-
Enable
Alloves to enable the scaling animation
Confirm with 4
L3 When you Run the project, changing the real-time value of Tag VAR0002,

\\J) you will see the movement through the path of the symbol. The size
(scaling) of the object will change consequently.

5.4. How to execute commands from
Objects

Execution commands can be assigned to objects in the screen’s user interface, in function
with their characteristics.

We will follow up the chapter reported above regarding graphic animation to complete the
argument by explaining the techniques used for assigning execution commands to object.
In our case we shall use a ‘Button’ object and a ‘Gauge’ object, which are needed to
produce the animation which we configured previously.

1. Activate the screen where the graphic symbols, described above, are inserted.

2. Take a ‘Gauge’ from the ToolBox’s "Sliders-Gauges-Meters" category and insert it in
the screen.

3. Take a ‘Green Button’ from the ToolBox’s ‘Buttons-Lights-Switches’ category and
insert it in the screen.
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5.5. Assigning Tag's value from Objects

Example Using Button Objects

Let’s proceed with configuring the button which we will use for acting on the variable used
for managing the rectangle’s (tube) color animation.

1. Double-click or use the other technique to display the inserted Green Button’s
Properties.

2. Select the Execution group from the properties window and then the 'ON-OFF'
Mechanic Style. Select the VARO0O0001 tag previously inserted. By using this
characteristic the button will toggle the Tag, by setting it with the ‘O’ and ‘1’ values. The
tag can also be interacted on by using the command selection as we will show you up
ahead.
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Properties »
Bl Button1 Button -
| 8y v | @
Chech Var. [l VARDDOOT [—
Mechanic Style CMN-OFF A
Impulsive Time 0
: 7
F
7
[] Enable Shortcut
Shortcut
[
[+
+
[+
+
+ o
]

I+

1
L«

Mechanic Style
Choose the mechanic style

{08l 5 ymbal Libraries 4 €3 Dynamic Help - F‘ru:uperﬁes

3. Confirm with ¥ .

Example Using Gauge Objects

Now we shall configure the gauge which we use to interact on the tag to manage the
created symbol’s animated movement.

1. Double click or use the other technique to display the inserted gauge’s Properties
Window.

2. Select the Variable group from the properties window and then select the Gauge-Slider
Variable item. Select the VAROOO2 tag previously inserted. In this way the gauge will
interact directly on the VAROOOO2 tag. The gauge object is totally configurable, by using
the numerous properties provided. It is only necessary to do the configuration as
indicated for our example. The other properties can be referred to in the Programmer’s
manual.
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Properties x
|{,} Gauge Gauge j
= 41 [B]=]] @

[zauge-Slider Wariable 7| YARDODD2
Fauge-Slider kin ariable [
Fauge-Slider b ax ariable [Tl

EEEEHEHHRBEEE

Gauge-5Shder ¥anable
Enter the variable for the Gauge-Slider Value

3. Confirm with v

- TIP: you can also drag the Tag from the project RealTime DB resource
J‘}) directly to the object on the screen, to simply assign the variable.

5.6. Assigning executing commands to
Objects

Different types of commands can be assigned to any command object (Buttons, Menu,
Accelerators) and command lists can also be created. The commands can be activated by
selecting the "Mechanic Style" on the Execution Properties as "Execute Command",
then defining the command type by selection the "Command on Release' or Command
on Pressed.

The button’s execution properties are:
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Shortcut
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Commands On Release .
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action
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When activating the ‘Commands’ selection from the Execution properties you can edit the
command list to be associated to the object by using the ‘Add New Command’ button in
the Command List window.

L o

Command List

add Mew Command.

Remove

|
Edit. .. |
|

Tip : Commands are
executed in the lisk
arder,

Crag and drop items in
khe list ko change the
execution order

ok |

Cancel |

I
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The ‘Add New Command’ button opens the settings window of the operating commands
to be assigned to the object.

Each configured command will be added to the Command List which the object will
execute.

Command Type

4 5, Variable Command r[; Synoptic Command ruﬁ‘ Scripk Command 3

Property M amne

W ariable =

Action zet

W alue

Strobe Time a

M ax. W alue 100, 000000
Min\Walue 0.000000

M ax.Chars 0

k. | Annulla 7

There are commands in Tags (Set, Reset, Toggle, Strobe, Increase, Decrease, Virtual
Keyboard...) or on Screen windows (with the various opening modalities).

- Please refer the manual for further details on all the command operation
\lf) which can be assigned to objects.

5.7. Start Runtime

At this point, with the objects configured we can run the project to verify its Runtime
behaviour.

1. Press the J‘ button or use the Start Project command from the File menu (or
ALT+F12).

2. Movicon will ask you to save the project. Save the project using the classic Windows
techniques.

3. After having saved the project on file, it will be executed in run mode where you can
operate the objects to see if they work.
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4. To return to Programming mode, use the ALT+F12 keys or the ‘J button from the
bar.

Note: (you can customize system menus by inserting all the commands desired as well as
for the Movicon or Windows shutdown from the project in Runtime mode).
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6. Alarms Management

6.1. How to Manage Alarms

In this brief lesson we will quickly see how to activate, display and record alarms in
Movicon projects.

We shall continue with our example from where we left off with a few Tags and a pair of
screens already predisposed in our project.

Note: The alarms are objects from the project. Each alarm has their own
General properties where they are assigned names and associated to tags.

Each alarm is built with at least one threshold, whose value and condition determine the
activation of the alarm with an associated text.

6.2. Inserting Alarm Objects

1. Select the ‘Alarm List’ Resource from the project window which in turn will show the
relative commands in the command Pane at the bottom.

2. Use the “Add a new Alarm” command from the Command Pane or with the right
mouse key. A new alarm object will be created in the project and can be renamed as
pleased.
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Project Explorer x

Resources | Device -
3 test®
Ggreal Time DB
£ . List variables (Tags) ...
ﬁﬁ List Comm,Drivers
(Q’F‘C Adapter
;@List Structure Prokat.. .
Resources
Ilsers And User Groups
ﬁData Loggers And Recipes
ﬂ.ﬁ.larm List {# Alarms 1", ...
& AL0001 =
B Event Chjeck List
IB scaling Object List
F™ scheduler Obiect List

'ﬂh Add a new Alarm Threshaold
“@ add a new Alarm

Activate the alarm object’s properties window to assign the desired name, i.e. ALLOO1,
then the Tag from the project by selecting it from those inserted in the project’s Real-Time
DB. In our example, the object’s properties are those indicated in the figure below:

Properties x
| @ ALD0O1 Alarm |
v X ||FE 2 @
=
M ame ALODDT
Device Mame
"Wariable 55| YARDODON
Enable % ariable g
Huysteresis 0.000000
[ Exclusive
[+ Enable
[v Quality Good Only
Yariable
Enter the variable [Tag] for thiz alarm

56



ALARMS MANAGEMENT

Important: if the ‘Quality Good Only’ is left checked the alarm will be
activated only when the RealTime DB assigns the tag with a certain value.
For instance, in cases where a Tag connected to a driver or in network,
becomes disconnected the value turns to ‘uncertain’ and therefore the alarm
will not appear. If in doubt, uncheck this option for a test run

3. After having entered the Alarm object, you can enter at least one activation
threshold. Therefore, select the alarm from the project Window and use the ‘Add a new
Alarm Threshold’ from the Commands Pane or use the right mouse key.

Project Explorer x

Resources | Condition -

L test”
Ggreal Time DB
&5 List Wariables (Tags) ...
ﬁi List Comm.Drivers
@, PC Adapter
mList Structure Protat, .,
Resources
IUsers And User Groups
ﬁDate Loggers And Recipes
ﬂ.ﬁ.larm Lisk (# Alarms '1', ...
& ALooon
|4 Threshold »=
Hf Fvent Object List
BB 5caling Cbject List
FA=chediler Ohiact | st hd

“@ Add a new aAlarm Threshold
“@ add a new Alarm

4. By doing this the alarm will show one intervention threshold which we will configure
through its properties.

5. We will configure the alarm’s activation on the value desired in the threshold properties
Window.

6. Go to the ‘General’ properties group to assign the ‘Title’ being the text which will be
associated to the alarm. The title can be typed directly in the property box or, as a good
rule, can reside in the project’'s ‘String Table’ and there may be subject to language
change.

from the project resource window and use the ‘Edit String Table’ command
from the Command Pane. Then insert the columns (each column is a text
language) and then proceed with inserting the texts which will then be
made available all over the project

\]::J Note: when using the string table, you need to select the project name

7. We then have to assign the threshold value in the ‘Value’ box in the ‘Execution’
property group. You can also use a ‘dynamic’ threshold value, where the alarm activation
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value derives from the contents of another tag. Leave the default activation >= (more
than or equal to).

8. The Style and Notification Event properties are of no interest to us for the time being
and therefore we will leave those for default.

e The alarm is historically logged in the file for default and can be traced or reset as
well as other characteristics to be referred to in the Programmer’s Manual.

Properties x
|,_.ﬂ Threshald Threshaold j
v X |[B2 i [B]7]] @
= -
M ame Threzhold ]
Brea
Title Emergency On
Help
Duration Meszzage Format
Read Access Level FFFF
Wite Access Level FFFF
=
Walue 1.000000
Threzhold % ariable W alue [
Condition »=
Severity 1
Delay 1]
=
[v Support ACK,
[v Support RESET b
[v Blink
[v Print
[+ Log
[ Speech
[ Repeat j
Style

The alarm and its activation threshold (each alarm can have a number of activation
thresholds) have now been configured.
We can now move on to how to view active alarms and those historically recorded on file.

6.3. Displaying Alarms

The active alarms, setup in the project’s Alarm List resource, can be displayed in purpose-
made object viewers which can be inserted on the screen.

We need the use of a screen. In our example project we have setup two screens,
‘Screenl’ and ‘Screen2’ where Screenl has already been used for the graphic examples.
Therefore we are left with Screen2 for this example.
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1. Double-click on ‘Screen2’, in the Resource folder from the project Window, to open it in
edit mode.
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2. Activate the Toolbox and take out an ‘Alarm Window’ object from the ‘Advanced
Shapes’ category.

3. Click on a point on the screen’s top left, then drag the selection to insert the ‘Alarms
Window’ object in the size desired.
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4. Double-click to activate the ‘Alarm Window’ object property. The Style property
permits you to fully configure the Alarm Viewer object. The Fill property permits you to
assign the background colour desired for the alarm’s window. The Font property permits
you to choose its characteristics as desired. The numerous properties, described in the
Programmer’s Manual, permit you to manage the viewing of alarms according to any
applied necessities. In our case, for simplicity, we will leave all the default settings as
they.

Properties

=
E.ﬁ.larm Window Alarm Window j

o 3 |3 4 | (7

= "
Border I© szunken —
[v Clickable

[v Auto Layout

[ Show Control Wnd

[v ack Sel Button

[v Ak Al Button

[v Reset Sel Button

[v Reset sl Button

[+ Toggle Sound Button

Button Size small
Align Buttons bottom
Ack Sel Button Test

Ak Al Button Text

Fezet Sel Button Text

Rezet All Button Test

Toagle Sound Button Tewxt

Tewt Column Hame

Alarm On Column Mame

Alarm ek Colurmn Mame

Alarm OfF Column Marme

Alarm Reset Column Mame ﬂ

Style

® You can modify, add or take away the columns describing the alarms in
the Alarms Viewer by using the appropriate tools, which are displayed
with the “Shift + Double-click’ in the same window.
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i

Q Screenl//g Screen2

[l 2 3 d 5 A

C =
Alarm Dezcription

Field Choice X

Tirme ACK.
Time OFF
Time RESET
Status

||?||||ﬁ|||5|||4|||3|||2|||1|||

6.4. Displaying Alarm's History

All the alarms are historically logged for default. The recording modalities and the
Historical Log archives management can be customized through the Historical Log
properties which is accessed by selecting the project name from the tree structure and
then using the properties Window.

To display the historical data of the alarms, you need to proceed as described above for
the Alarms Viewers.

Apart from the Alarm Viewers you will also find the Historical Log Viewer in the ToolBox.
Carry out the same procedures for inserting the Historical Log as described above for the
Alarms Viewer.
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All we have to now is verify what we have done. For this we need the following function in
the project, considering all that has been realized up to this point:

1. A command for alarm simulation on the alarms page.
2. The change page commands.

6.5. Create a Simulation

We shall find room in the Alarms screen window to insert a command object which will
interact on the VAROOOO1 tag associated to the alarms.

1. Open ‘Screen2’ from the project window. Arrange the viewer objects so that the is
enough space left for inserting the other objects (i.e. on the bottom border).

2. Insert a ‘switch’ object from the Toolbox and position it on the bottom border.
Activate its properties and assigned the VAROOOO1 tag in the Execution properties.

=
Check Var, g YAR00001
[v Checked
[ Enable Shaortcut
Shortcut
[v Show 5hartcut

The switch object will interact on the VAROOOO1 tag, which we have already assigned to
the Alarm object.
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3. Insert another new ‘button’ object, again from the Toolbox, as before. Position it on

the bottom border at the side of the switch.

Activate its properties and assign the opening

of ‘Screenl’ in the Execution properties. This button will then permit us to execute a page

change to return back to the first page.

Command Type

ﬁ

4 5, Variable Cu:ummanVl; Synoptic Cammand rwﬁ Script Cormmand 3

Froperty

Synoptic [Screen|
Action

Manitor
Farameter file

* pog

¥ pos

Width

Height

[w Caption

[+ Border

[ Resize border
[ SyeMenu

[ Mavimized Box
[ Minimized Box

Synoptic [Screen]
Enter the synoptic resource name

o]

M ame

Q Screenl v -
open normal [(MDI child)

1]

100
100

Annulla ?

4. Now we can insert the same object into ‘Screenl’, the startup screen, so that we can

dispose the open Alarms page command.

The button object’s ‘Cut & Paste’ can also be

used to dispose it on another screen after which its properties can be modified.

Executing Runtime

We now have the necessary items arranged in our example project to test run it:

® Screenl: graphic simulation screen,

with command and graphic animation

objects. The appropriate button is used for accessing Screen2.
e Screen2: Alarms simulation screen, with the alarms activation and viewer objects.

At this point, we are all set for executing a test run of the project to verify its behaviour

during Runtime.

1. press the J‘ button or use the Start Project command from the File menu (or

ALT+F12).

2. Movicon will ask you to execute a project save. Execute the save according to the usual

Windows’ techniques.

3. After having saved the project file, it will be put into run mode letting you try out the

objects to see if they work.

63



TUTORIAL

4. To return to Programming mode use the ALT+F12 keys or the n button from the bar.

LD Note: (you can customize a system menu by inserting all the commands desired,
including the ones for shutting down Movicon or Windows from the project in
Runtime mode).

The picture show an example of our simulation.
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